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1. Preface

MakeDoc for TIBCO is used to generate HTML, PDF and DOCX formatted documentation for TIBCO
BusinessWorks, TIBCO BusinessEvents, TIBCO iProcess projects and TIBCO EMS Servers. The applic-
ation is written in Java and is portable among different operating systems. Documentation can be gener-
ated from a TIBCO BW/BE/iProcess project folder, EMS Servers, TIBCO Designer EAR archives. Make-
Doc for TIBCO can generate documentation from related design-time libraries (.projlib files) when config-
ured properly.

The generated documentation is detailed and well organized. Text documentation is generated for all im-
portant components of TIBCO BW/BE/iProcess projects and EMS servers. The graphical representati-
on of TIBCO BW processes, BE state machines and BE concept views is similar to the TIBCO Designer.
XSD and WSDL diagrams are generated as well.

MakeDoc for TIBCO first creates the document in DITA format. The DITA format is transformed into the
user selected formats: HTML, PDF and DOCX.

The HTML document is hyper-linked, which makes navigation easy and fast. The document consists of
HTML documents organized in a tree structure. The main document index.html is stored in the snapshot-
_dir\html folder. Other files associated with the HTML document are saved in subfolders.

The PDF document is hyper-linked too. The contents of this document is also displayed in bookmarks.
The document is stored in the snapshot_dir\pdf folder.

The Microsoft Office Word 2007 Open XML Macro-Enabled Document (.docm) file can be generated
as well. The Microsoft Office Word is professional-looking document, which allows user fully customize
generated documentation. The document is stored in the snapshot_dir\docx folder.

The generated document has the same contents in all output formats.

MakeDoc also provides Quality Assurance feature. This tool is able to check whether defined rules were
followed in chosen projects and shows all occurences of violations of these rules. Quality Assurance out-
put is generated with Project and Cross-reference part of documentation or as a standalone HTML docu-
ment, which can be also opened from MakeDoc main window.

The next feature is CrossReference. This tool is able to start generating documentation of more then
one documentation project type. It means that you can generate documentation of BW projects, BE
projects in one step. And also make link between these projects.

The last but not least is Repository Analyst feature. This tool is able to compare two generated docum-
entation and identify changes between these outputs.
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2. MakeDoc Modules

MakeDoc has modular architecture based on OSGI industry standard.

Following modules are currently available:
• Base Module
• TIBCO Products

• TIBCO BusinessWorks Module
• TIBCO BusinessEvents Module
• TIBCO EMS Module
• TIBCO iProcess Module

• CrossReference Module
• RepositoryAnalyst Module
• QualityAssurance

Figure1. MakeDoc Modular Architecture

2.1. Base Module
Base Module is prerequisite for all other modules. It must be installed before all others. You can image
this like chassis of a car.
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From end-user perspective there are three topics that brought by Base Module and therefore covered by
this document:

• Configuration principles
• GUI principles
• MakeDoc Storage
• MakeDoc Portal

2.1.1. Common GUI Principles

Base Module defines GUI principles that are common for all other modules. Complete MakeDoc GUI is
Eclipse based application. Please refer Eclipse documentation for details.

2.1.1.1. Standard Workspace

Upon startup following workspace is displayed.

Figure2. Standard Workspace

1. MakeDoc Explorer

Shows MakeDoc projects.
2. Dialogs

All dialogs appears in this location.
3. Console

After triggering generation process, the logs are displayed at this place.
4. Problems

Validation works over the entire workspace and results (errors) are displayed right here.
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2.1.1.2. Wizards

Every installed MakeDoc module has unique sets of objects that can compose its project. These objects
are either projects or files within the projects. There is create wizard for each object.
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Figure3. List of Wizards

Once wizard is finished object is added into project.
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2.1.2. Configuration

Base Module defines principles that are common for all other modules.

Main MakeDoc configuration location is

${user_home}/MakeDocConfig

. Every module has its own configuration file stored under this directory. For module specific configuration
please refer Module's documentation.

Base Module configuration is stored in file

general.properties.

. There are several important properties.

Parameter Default value Description

general.makedoc.prod Set during installation. Location where MakeDoc is inst-
alled.

general.licence.file ${user.home}/MakeDocConfig/li-
cense/customer.key

Location of license key.

general.storages.register JSON format Register of storages, their locati-
ons. For details refer Storage do-
cumentation.

general.storages.portal.*  ' Location of Portal templates and
output directory. For details refer
Portal documentation.

2.1.3. Storage

Storage is mutual component that maintains all generated documents. Every time MakeDoc generates
documentation it is stored into separated directory on a hard disk and some Metadata goes also into em-
bedded H2 SQL database.

Storage SQL database is started automatically after starting GUI or ANT job.

2.1.3.1. GUI

Storage GUI is available upon startup as a stand-alone tab.

It displays on the first level storages available on system. The second level shows Repositories. Records
are displayed on last level.
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Figure4. Storage GUI

If Storage GUI is not visible go to Window->Show View->Other select MakeDoc->Storage.

It provides following functionality:

• Browse generated outputs. Generated documentation/logs/folders can be accessed via right->cli-
ck menu or through buttons.

• Regenerate outputs. You can regenerate formats of the given snapshot.
• Delete generated outputs. Generated documentation (outputs) can be deleted via right->click

menu. Several records can be selected by holding Shift or Ctrl button, these records can be also
deleted together. Or all groups or repositories can be deleted via context menu.

• Clean storage. Storage can get into inconsistent state due to manual or administrative tasks. I.e.
deletion of some records directly on disk. In this case it is necessary synchronized internal SQL dat-
abase against disk directory. This can take a while on large installations.

2.1.3.2. ANT Interface

Besides GUI Interface there is also command-line interface, that enables Administrators interact with
Storage from scripts.

To use ANT Interface use following in User_Home/MakeDocConfig directory:

ant -f commons storage.COMMAND

Following commands are available:

• storage.start It starts storage process.
• storage.stop It stops storage process.
• storage.drop It completely wipes out complete storage.
• storage.cleanup Storage can get into inconsistent state due to manual or administrative tasks. I.e.

deletion of some records directly on disk. In this case it is necessary synchronized internal SQL dat-
abase against disk directory. This can take a while on large installations.

• storage.portal It recreates web portal interface. See more Portal Module documentation for more
details.

2.1.3.3. Configuration
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Configuration of all storages are kept in ~/MakeDocConfig/general.properties file. Example of code:

general.storages.register={"storages":[      {         "name":"default",         "d
bLocation":"~/MakeDocConfig/storages/default.db",         "recLocation":"~/MakeDocC
onfig/storages/default"      }]}
general.storages.register={"storages":[      {         "nam
e":"default",         "dbLocation":"~/MakeDocConfig/storages/default.db",      
   "recLocation":"~/MakeDoc
general.storages.register={"storages":[      {    
     "name":"default",         "dbLocation":"~/MakeDocConfig/storages/default.d
b",         "recLocation"
general.storages.register={"storages":[      {    
     "name":"default",         "dbLocation":"~/MakeDocConfig/storages/default.d
b",         "recLocation"
general.storages.register={"storages":
[      {         "name":"default",         "dbLocation":"~/MakeDocConfi
g/storages/default.db",     
general.storages.register={"storage
s":[      {         "name":"defa
ult",         "dbLocation":"
 "name":
"

There can be defined more than one storage. Typically only one "default" storage is sufficient. Several
modules like RepositoryAnalyst or CrossReference can work only on records stored within one storage.

2.1.4. Portal

Portal automatically creates web portal of all MakeDoc storages. This feature especially used on server
installations.

2.1.4.1. Setup

Portal using template engine that enables generate several views to MakeDoc repository. It comes out of
the box with predefined templates. Beside these predefined templates end-user also can create own tem-
plates. The engine is FreeMarker so the templates has to comply FreeMarker Templates Language.

Portal requires two directories as input. The first contains all templates. The second directory is output di-
rectory for generated html. Location of these directories is stored in general.properties file:

        general.storages.portal.src=${user.home}/MakeDocConfig/portal/src        gene
ral.storages.portal.out=${user.home}/MakeDocConfig/portal/out      
        general.storages.por
tal.src=${user.home}/MakeDocConfig/portal/src        general.storag
src=${user

2.1.4.2. Generated Output

Portal generates a HTML output and describe your MakeDoc Storage environment. It also provides easy
way how to get MakeDoc outputs. Portal has 2 basic layouts:

• Single page layout - all storages are displayed at one page as a list of storages.
• Multi page layout - storages are displayed as a list of links to separated pages on the main page.

Every record in table has 6 columns and represents output of one generation process.

• Date - date of the generation process.
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• Day of week - which day of the week.
• Generated output - set of the formats (HTML, PDF, DOCX), that was generated and they are dis-

played like a direct links to these outputs.
• Statistics BPM - this column contains statistics when generated output of BPM is Repository Anal-

ytics type. Displays counts of added, changed, removed items of the projects as links to the RA out-
puts.

• Statistics ESB - this column contains statistics when generated output of ESB is Repository Analy-
tics type. Displays counts of added, changed, removed items of the projects as links to the RA outp-
uts.

• Dependency - contains compared snapshots (OLD and NEW), when generated output is Reposito-
ry Analytics type.

Figure5. Portal example

2.2. TIBCO BusinessWorks Module
TIBCO BusinessWorks module allows user to generate documentation from selected TIBCO Business-
Works sources, such as directories with sources or EARs, and TIBCO BusinessEvents up to version 3.0.

2.2.1. Configuration

Configuration of MakeDoc for TIBCO BusinessWorks module is stored in ${user.home}/MakeDocConfi-
g/falcon.properties.

Property file contains:

 # falcon engine internal configuration falcon.config=${user.home}/MakeDocConfig/fal
con/engine.properties settings.module=FALCON settings.type=SNAPSHOT # paths to TIBCO
 products # TIBCO home tibco.home_path= # TIBCO BusinessWorks home tibco.bw_home= #
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 TIBCO BusinessEvents home (up to 3.0) tibco.oldbe_home= # TIBCO runtime agent home
 tibco.tra_home=       
 # falcon engine internal configuration falcon.config=${user
.home}/MakeDocConfig/falcon/engine.properties settings.module=FALCON settings.type
=SNAPSHOT # paths to TIBCO products # TIBCO home tibco.home_path= # TIBCO BusinessWorks
 home tibco.bw_home= # TIBCO BusinessEvents home (up to 3.0) tibco.oldbe_home=
 # TIBCO runtime agent home tibco.
 # falcon engine intern
al configuration falcon.config=${user.home}/MakeDocConfig/falcon/engine
.properties settings.module=FALCON settings.type=SNAPSHOT # paths to TIBCO
 products # TIBCO home tibco.home_path= # TIBCO BusinessWorks home tibco.bw_home= # 
TIBCO BusinessEvents home (up to 3.0)
 # falcon engine intern
al configuration falcon.config=${user.home}/Ma
keDocConfig/falcon/engine.properties settings.module=FALCON settings.type=S
NAPSHOT # paths to TIBCO products # TIBCO home tibco.home_path= # TIBCO BusinessWorks home 
tibco.bw_home= # TIBCO BusinessE
 # falcon engine intern
al configuration falcon.
config=${user.home}/MakeDocConfig/falcon/engine.properties settings.module=FAL
CON settings.type=SNAPSHOT # paths to TIBCO products # TIBCO home tibco.home_pat
h= # TIBCO BusinessWorks home tibco.bw_
 # falcon engine intern
al configuration fal
con.config=${user.home}/MakeDocConfig/falcon/engine.properties settings.m
odule=FALCON settings.type=SNAPSHOT # paths to TIBCO products # TIBCO home tibco.hom
e_path= # TIBCO BusinessWorks home tibco.b
 # falcon engine intern
al configuration fal
con.config=${user.home}/MakeDocConfig/falcon/engine.properties settings.
module=FALCON settings.type=SNAPSHOT # paths to TIBCO products # TIBCO home tibco.h
ome_path= # TIBCO BusinessWorks home tibco
 # falcon engine intern
al configuration fal
con.config=${user.home}/MakeDocConfig/falcon/engine.prop
erties settings.module=FALCON settings.type=SNAPSHOT # paths to TIBCO products # 
TIBCO home tibco.home_path= # TIBCO
 # falcon engine intern
al configuration fal
con.config=${user.home}/MakeDocConfig/falcon/engine.
properties settings.module=FALCON settings.type=SNAPSHOT # paths to TIBCO products
 # TIBCO home tibco.home_path= #
 # falcon engine intern
al configuration
 falcon.config=${user.home}/MakeDocC
onfig/falcon/engine.properties settings.module=FALCON settings.type=SNAPSH
OT # paths to TIBCO products # TIBCO home tibco.h
 # falcon engine intern
al configuration
 falcon.config=${user.home}/MakeDocC
onfig/falcon/engine.properties settings.module=FALCON settings.
type=SNAPSHOT # paths to TIBCO products # TIBCO
 # falcon engine intern
al configuration
 falcon.config=${user.home}/MakeDocC
onfig/falcon/engine.properties settings.module
=FALCON settings.type=SNAPSHOT # paths to 
 # falcon engine intern
al configuration
 falcon.config=${user.home}/MakeDocC
onfig/falcon/engine.properties settings.m
odule=FALCON settings.type=SNAPSHOT # 
tings.ty
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2.2.2. Setup

This chapter provides step-by-step tutorial how to automatically generate documentation for TIBCO Busi-
nessWorks integration projects by the help of MakeDoc for TIBCO BusinessWorks (BW) module. In this
chapter some terms defined in previous chapters are used.

To successfully generate TIBCO BusinessWorks documentation we need to create instance of MakeDoc
for TIBCO Business Works project. To do so go to File -> New -> Other or use shortcut Ctrl+N. Then ex-
pand MakeDoc for TIBCO Business Works folder and choose MakeDoc for TIBCO Business Works doc-
umentation project.

Figure6. Creating new MakeDoc for BW documentation project

MakeDoc shows wizard which helps us to create our MakeDoc BW documentation project. We need to
provide project name and click Finish. This name distinguish this project from other created projects.
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Figure7. Setting the name of the new project

MakeDoc will now create BW documentation project with basic structure.

Figure8. Initial documentation project structure

Remember that MakeDoc uses file-based philosophy. Almost every element in MakeDoc terminology is
represented by a file.

These elements are:

• Project (.project) - represents one integration project (in this case one TIBCO BW project), term
documentation unit can be used too in next paragraphs.

• Library (.library) - optional, represents one TIBCO BW Design time library (DTL)
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• Aliases (.aliases) - optional, represents alias to DTL mapping. More than one alias can be mapped
to one DTL.

• Profile (.profile) - uses all previously defined elements to define one specific MakeDoc for TIBCO
BW run.

Note: folder "Templates" contains XSL templates and other files needed to generate documentation for
TIBCO BW. By editing these templates user can influence final appearance of generated documentation.
Purposes of folders Filters and Rules are explained in other parts of this user manual.

For every type of file corresponding folder is created. It is recommended to use corresponding folders for
files but it is not necessary.

In following parts we will create all these elements to successfully generate our documentation.

2.2.2.1. Working with projects

Integration projects are in MakeDoc represented by files with .project extension in general. Let's create
some of these files. We can create more .project files in one step in batch manner.

At first try to create one .project file. We can create it by adding source folder or deployment file. Right-cli-
ck on Projects folder in MakeDoc Explorer and choose New->BusinessWorks project.

Because adding units one by one is not effectively in most cases, MakeDoc can add multiple units in one
step for you. For this purpose New Multiple BusinessWorks projects wizard was designed. Right-click on
Projects and choose New->BusinessWorks projects. Navigate to ${MAKEDOC_HOME}/demo/tibco/input-
/1/bw. MakeDoc will search for all TIBCO BW Projects stored in this folder. It is possible to search for:

• source folders
• deployments
• both - folders and deployments
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Figure9. New Multiple BusinessWorks projects wizard

Let's say that we would like to add deployments only so uncheck "Projects" and click Next. Wizard aut-
omatically detects deployments configurations if there is configuration file with same name in folder with
target deployment.

Figure10. New Multiple BusinessWorks projects wizard - search results

Click Finish to add all deployment files. Projects folder now contains four items as shows following image.
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Figure11. MakeDoc Explorer - added units

So we have successfully added new units we need to document. To be able to change configuration of
existing projects MakeDoc provides project editor. This editor starts when .project file is clicked.

Figure12. Project editor

2.2.2.2. Working with design time libraries and aliases

MakeDoc is able to document TIBCO BusinessWorks design time libraries. In this chapter we will go thro-
ugh DTL setup. As well as other resources DTL is represented by file. To document DTL we have to add
DTL resource to our documentation project. Process of adding DTL is very similar to project creation. It
holds wizard-editor fashion and offers batch DTLs files creation too.

To add DTLs files click right-click on Libraries folder in MakeDoc Explorer and run New->BusinessWorks
Design Time Libraries. MakeDoc starts DTLs files creation wizard. Click Browse and navigate to the fold-
er you would like to recursively search DTLs for. In this example it is C:/Examples/bw.
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Figure13. New multiple BusinessWorks Project Libraries Wizard

MakeDoc will now search for DTLs in selected folder. By default all detected libraries are selected for ad-
dition.
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Figure14. Add multiple BusinessWorks Project Libraries Wizard - result page

Click Finish to add DTLs to our project. MakeDoc Explorer now should look like this:

Figure15. MakeDoc Explorer - added libraries

To edit DTL settings just click on corresponding file and DTL editor is opened immediately.
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Figure16. DTL file editor
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Figure17. Aliases mapping creation wizard

To successfully document DTLs we need to do one more step - define alias-to-library mapping. It's the
same as in previous parts, MakeDoc has pair wizard-editor for this task. Go to MakeDoc Explorer, open
context menu for Aliases folder and run New->BusinessWorks Aliases Mapping. On the first page enter
file name for newly created aliases mapping file. Aliases file has extension .aliases but there is no need
to enter it, MakeDoc adds it for you automatically. Click Next.

Next page shows simple default mapping. By default alias has the same name as library file alias is
mapped to.
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Figure18. Default aliases mapping

If this not meet user's requirements there is an editor provided. This editor is opened when user clicks on
aliases mapping file. By the help of this editor it is possible to fine-tune aliases mapping. It is possible to
add new alias, delete it, change name of alias or change library file it is mapped to. Dropdown-lists are
pre-filled with all the DTLs our project consist of.
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Figure19. Aliases mapping editor

2.2.2.3. Working with profiles

At this moment we are almost ready to generate documentation of TIBCO BusinessWorks middleware.
We have defined all prerequisites. Last step remains. We need to create profile. Profile is MakeDoc arti-
fact represented by file as well as other artifacts we know already. Profile aggregates all artifacts defined
in previous steps. We can say that profile defines properties of one MakeDoc for TIBCO BusinessWorks
generation run and allows us to start it.

Every MakeDoc for TIBCO BusinessWorks documentation project comes with three profiles (Enterprise.-
profile, Printable.profile, QAOnly.profile). If user needs explicitly create another one there is wizard-editor
pair provided to achieve this.

Right-click on Profiles folder in MakeDoc Explorer and choose New->BusinessWorks Profile. First page
let us decide which profile template use as default configuration of our new profile. There are three opti-
ons. Enterprise profile is preconfigured to generate full documentation, Printable profile is suitable for pri-
nting, QAOnly generate only Quality Assurance Documentation.
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Figure20. Add BusinessWorks profile wizard

Choose Enterprise profile and click Next.
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Figure21. Add BusinessWorks profile wizard - destination page

Now enter the filename for newly created profile. Profile file has extension .profile. Again no need to enter
it, MakeDoc appends it automatically.
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Figure22. Newly added profile

Look for this profile in project tree and open it. TIBCO BusinessWorks profile editor consists of four pages
• Profile general settings
• Units
• Global Variables
• Quality Assurance

Figure23. Profile editor

General settings page is divided into three sections:

• Profile info - holds basic identification information for this profile
• Profile name
• Author
• Description

• Output settings - contains these settings:
• Output formats generated for this profile (HTML, PDF and DOCX are supported)
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• Paper format (A4 or letter)
• Filters - dropdown list for choosing filter settings (see Filters chapter)
• Aliases - dropdown list for choosing aliases settings (see Libraries and aliases chapter)
• Document all units - yes/no option, if checked, all units of project are automatically document-

ed in this profile
• Automatically check Quality Assurance - full QA check of units is performed in generation pro-

cess
• Storage settings - allows us to choose storage used to save generated snapshots of documentation

As aliases select from combo Aliases/aliases_mapping.aliases. Check document all units and Automatic-
ally check Quality Assurance.

Units page determines subset of units of our documentation project. This subset is documented when us-
er starts generation process for this profile. If Document all units option was selected in general settings,
widgets on this page are disabled.

Global Variables page allows to enable or disable global variables substitution.

Quality Assurance page allows user to influence Quality Assurance check performed as a part of genera-
tion process in detail. For more informations see Quality Assurance chapter in this manual.

So BusinessWorks profile is central point of MakeDoc for TIBCO BusinessWorks project. It is possible to
understand it as subset of units included in project together with other settings (such as output formats).
These settings influences final content of documentation. Now save profile and hit 'Generate documenta-
tion' button to start generation process.

MakeDoc now goes through phases of generation process, generates:

• project documentation for each unit from profile
• BusinessWorks to BusinessWorks cross-reference documentation
• Quality Assurance documentation

Generation process successfully ends with 'BUILD SUCCESSFUL' message.

Click on MakeDoc storage view (left side of the main screen). Right click on generated snapshot and
choose HTML. We are ready now to inspect generated output in next part of the text.

Figure24. MakeDoc Storage - generated output

2.2.3. Generated output

Documentation can be generated in HTML, PDF and DOCX format. If not reduced by filters, each HTML
document contains a tree navigation divided into three main parts - Project documentation, Cross-refere-
nce documentation and Quality Assurance documentation. The Project documentation part contains list
of projects and each project contains all its resources. Cross-reference documentation shows relation-
ships between projects. Quality Assurance documentation contains list of violations detected in docume-
nted projects, QA Rules summary and list of the invalid QA Rules. Navigation items are links to HTML do-
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cuments and the menu is updated according to actually displayed content. The PDF documentation has
bookmarks which are similar in structure to the HTML navigation. The DOCX documentation is another
printable file format, which is also easy to edit and format.

Figure25. Example of HTML navigation

2.2.3.1. How To Use HTML Documentation

The HTML documentation is saved in "HTML" subfolder of your generated folder. HTML page consists of
4 frames.
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Figure26. Header page of HTML

1. Header frame

Header frame contains customer's logo, name of project, generated date and time.

2. Title frame

Title frame can be used for simple manipulation with page. One can hide Navigation frame by clicking
"Hide menu" or hide Title frame by clicking "Hide title".

3. Navigation frame

Navigation frame contains whole menu tree. For easier navigation one can use buttons "Expand all", "Co-
llapse all" and "Find in menu" on the top of frame.

• Expand all - open all items in menu.
• Collapse all - close all items in menu.
• Find in menu - find page displayed in Main frame in menu.

4. Main frame

The main frame displays generated documentation.

2.2.3.2. Search functionality

It is possible to use search functionality in generated HTML document. It can be done through typing
search expression into input box and pressing search button. Also advanced searching expressions can
be used for this purpose including boolean expressions (if more words are typed, OR relation is used by
default between them).
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Figure27. HTML search

Basically the functionality is done by using Java applet in documentation to search in document placed
in local folders or in the intranet.

It is also possible to utilize searching on web server - for this purpose jsp pages are used. There's ne-
ed to download and install Apache Tomcat from  http://tomcat.apache.org . Then exact path to generated
documentation can be set as root webapps directory - file conf/server.xml, element Host, attribute appb-
ase. This can be very useful to set in generation script to change this directory to lastly generated HTML
snapshot.

Note: If Mozilla Firefox is used for local browsing, there's need to use JRE of version 1.6.0_10 or newer
for applet functionality.

2.2.3.3. ESB documentation

Figure28. Example of HTML ESB project documentation
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2.2.3.3.1. Project Documentation

The Project documentation section contains one chapter for each project in the solution. The focus of this
chapter is on the message and data processing performed by the process. The chapter layout is similar
to the layout of the TIBCO Designer. A project documentation may contain some or all of sections depen-
ding on filter settings.

2.2.3.3.1.1. Supported Resources

MakeDoc for TIBCO supports these resources:

• Archives
• Adapters
• AE Schemas
• BE Concepts and Concept views
• BE Channels
• BE Events and Time events
• BE Rule sets and functions
• BE Scorecards
• BusinessConnects
• Global Variables
• HTTP Proxies
• JMS connections
• JNDI configurations
• Job Shared Variables
• Processes
• RV Transports
• Services
• Shared FTP
• Shared HTTP
• Shared iProcess Connections
• Shared JDBC
• Shared JMS connections
• Shared Parse Data
• Shared Variables
• WSDLs
• XSD Schemas

2.2.3.3.1.2. Processes

Process documentation consists of description, diagram and configuration.
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Figure29. Process description and process graph

The process graph and description are taken directly from the TIBCO project.
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Figure30. Process configuration

The process configuration contains the details of all activities, transitions and groups in the process.

Mapper Activity

For the mapper activity there is documentation of input bindings presented in a simple table.

Figure31. Input bindings are documented for Mapper activity
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2.2.3.3.1.3. Adapters

Adapter documentation is generated for TIBCO Adapters:

• Generic adapter
• TIBCO Adapter for ActiveDatabase
• TIBCO Adapter for CICS
• TIBCO Adapter for ClarifyCRM
• TIBCO Adapter for COM
• TIBCO Adapter for Corba
• TIBCO Adapter for EJB
• TIBCO Adapter for Files
• TIBCO Adapter for IBM AS/400
• TIBCO Adapter for Infranet
• TIBCO Adapter for JDE OneWorld Xe
• TIBCO Adapter for Kenan BP
• TIBCO Adapter for LDAP
• TIBCO Adapter for Lotus Notes
• TIBCO Adapter for MQSeries
• TIBCO Adapter for Oracle Applications
• TIBCO Adapter for PeopleSoft
• TIBCO Adapter for Remedy
• TIBCO Adapter for SAP
• TIBCO Adapter for Siebel
• TIBCO Adapter for SWIFT
• TIBCO Adapter for Teradata
• TIBCO Adapter for Tuxedo
• TIBCO Adapter SDK

Documentation of adapters contains all adapter's configuration and settings divided into following parts:

• Description
• Startup
• Deployment - contains list of advisories, sessions, producers, consumers, servers and clients
• Timers
• Log sinks
• Metadata
• Adapter services
• Adapter configuration
• Hawk microagents
• Other objects

There are extra parts of documentation for some of adapter types.

2.2.3.3.1.4. AE Schemas

AE schema documentation consists of classes, sequences, scalar types, unions and associations.

2.2.3.3.1.5. XSD Schemas

XSD schema documentation consists of diagram, attributes and overview (elements, complex types, sim-
ple types, attributes, groups, attribute groups, redefines, notations, detail).
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Figure32. Example of XSD Schema documentation

2.2.3.3.1.6. WSDLs

WSDL documentation consists of diagram, namespaces, types, port configuration, operations and mess-
ages. The diagram is generated for the concrete WSDLs only.
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Figure33. Example of WSDL documentation

2.2.3.3.1.7. BE Concepts

BE concepts documentation consists of description, parent concept, concept properties and state mac-
hines. For each state machine there is its diagram.
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Figure34. Example of BE Concept documentation

2.2.3.3.1.8. BE Concept Views

BE concept views documentation consists of description, figure and concepts.

http://www.pikeelectronic.com/


Date: 07/26/13

MakeDoc - User Manual

License owner: PIKE ELECTRONIC
MakeDoc for TIBCO made by PIKE ELECTRONIC.    All Rights Reserved. Page 39 of 152

Figure35. Example of BE Concept view documentation

2.2.3.4. Cross-Reference Documentation

This section contains three main subsections. Global Variables, Destinations and Database Objects.

2.2.3.4.1. Destinations

The Destinations section of the document references information of all projects in the MakeDoc for TIB-
CO solution. It contains two sub sections.

The first section is a list of all the process destinations. This is a list of all process inputs and outputs from
or to a unique JMS queue, SOAP, Business event or Rendezvous message and JDBC Connections. The
project, process and activity using the message are hyper-linked.

Destination documentation contains the visual cross-reference where the user can see near destination
neighborhood. Actually opened destination has yellow border for simpler orientation in the diagram. Eve-
ry diagram element is hyper-linked to its documentation page.
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Figure36. Example of destination detail
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The second section is a list of projects and the destinations accessed by the project. A summary list of
the messages used by the process is presented. Then for each item in this list a detail description of the
message is presented.

Figure37. Example of project reference
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Figure38. Example of message detail

2.2.3.4.2. Global Variables

The Global Variables section of the document references information of all projects in the MakeDoc for
TIBCO solution. It contains two subsections.

The first section Global Variables Reference is a list of all global variables. Global variables are struct-
ured similar to TIBCO Designer, but this structure is built among all project in the MakeDoc for TIBCO so-
lution. Each global variable documentation contains table of its values, because global variable can be
defined in more than one project. Hyper-links to referencing resources (e.g. processes, connections) are
also included.
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Figure39. Example of global variable reference

The second section Projects Reference is a list of projects. For each project a summary list of the refer-
enced global variables is presented.

Figure40. Example of project reference
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2.2.3.4.3. Database Objects

The Database Objects section of the document gives overview of relations among Projects and Database
objects. It identifies which database object (table, view, stored procedure) is used by specific Project (and
process) and vice versa. It contains two subsections.

Database Object Reference contains all database objects, that are somehow used by documented TIB-
CO projects, grouped by connection string and SQL action which is performed on such object (SELECT,
UPDATE, INSERT, DELETE, CALL).

Figure41. Example of database table : Customer

Project Reference is a list of projects. For each project a list of referenced database objects is presente-
d.

2.3. TIBCO BusinessEvents Module
TIBCO BusinessEvents Module allows to generate documentation from selected TIBCO BusinessEvents
sources, such as directories with sources or EARs. TIBCO BusinessEvents Module can work with Busi-
nessEvents project created under TIBCO BusinessEvents 4.0.x or TIBCO BusinessEvents 5.x.

All processes described in this chapter can be used in TIBCO BusinessEvents Module.

2.3.1. Setup

Chapter describes how to setup the module. It starts with dialogs and then it continues with configuration
files.

2.3.1.1. Configuration

Configuration of TIBCO BusinessEvents Modules is stored in ~/MakeDocConfig/bebe.properties for TIB-
CO BusinessEvents Module.

Property files contains:

settings.module=BEBEsettings.type=SNAPSHOTtibco.be_home=C:/tibco/be/4.0tibco.home_pat
h=C:/tibco 

settings.module=BEBEsettings.type=SNAPSHOTtibco.be_home=C:/tibco/be/4.0
tibco.home
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settings.module=BEBEsettings.type=SNAPSHOTtibco.be
_home=C:/

settings.module=BEBEsetting
s.type=S
u

File bebe.properties contains paths to TIBCO BusinessEvents 4.0 or paths to TIBCO BusinessEvents 5.-
0.

2.3.1.2. Dialogs

Chapter describes dialogs in module for TIBCO BusinessEvents.

2.3.1.2.1. Creating TIBCO BusinessEvents Module Project

Chapter describes creation of TIBCO BusinessEvents Module project.

Figure42. New TIBCO BusinessEvents Module Project wizard

Name of project can be set in next wizard page.
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Figure43. New TIBCO BusinessEvents Module Project wizard - Project Name

MakeDoc creates main project structure after pressing Finish.

Figure44. Created project structure

Project contains nine folders:
• Custom Functions - contains added functions used by TIBCO projects.
• Filters - contains filters for reducing generated documentation
• Profiles - contains profiles for selecting TIBCO BusinessEvents project to document, output format

of documentation and selecting of applied QualityAssurance rules
• Project Libraries - contains project libraries used by TIBCO projects.
• Projects - contains all TIBCO BusinessEvents projects to document
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• Rules - contains QualityAssurance rules
• Templates - contains FreeMarker templates
• ThirdParty Libraries - contains libraries of the third party used by TIBCO projects.
• Validators - contains Validators for TIBCO BE projects.

2.3.1.2.2. Working with TIBCO BusinessEvents projects

Chapter describes creating and editing TIBCO BusinessEvents projects. TIBCO BusinessEvents project
can link to directory with TIBCO BusinessEvents project sources or EAR file with configuration file.

2.3.1.2.2.1. Creating TIBCO BusinessEvents project

TIBCO BusinessEvents project can be created by New Multiple BusinessEvents Projects wizard. New
Multiple BusinessEvents Projects wizard allows create more TIBCO BusinessEvents projects by one
step.

Creating multiple BusinessEvents projects

Right click on Project folder in TIBCO BusinessEvents Module project and select New > BusinessEvents
Project

Figure45. Multiple BusinessEvents Projects

New Multiple BusinessEvents Projects wizard allows selection of desired type of source - Folders and
EARs. After setting URL to directory, wizard tries to find all sources in selected folder recursively and
shows all found TIBCO BusinessEvents Projects for selecting or deselecting found projects.
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Figure46. Found BusinessEvents projects

Figure47. Created projects by Multiple BusinessEvents Projects

2.3.1.2.2.2. Editing BusinessEvents project

Existing BusinessEvents projects can be modified by BusinessEvents Project Editor. Editor allows
change path to TIBCO BusinessEvents source directory or EAR and EAR configuration file.
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Figure48. BusinessEvents Project Editor with directory source

Figure49. BusinessEvents Project Editor with EAR source
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2.3.1.2.3. Working with Profiles
Chapter describes working with Profiles. Three Profiles are created automatically. Profiles allow:

• start documentation process
• set output format - HTML, PDF, DOCX
• set paper format
• set filter
• set Storage setting - Storage, Repository location
• set subset of units to be documented in this profile when 'Document all units' option is not used
• set Quality Assurance rules
• set Project Libraries
• set Custom Functions
• set Validators

Figure50. Default Profiles in project

2.3.1.2.3.1. Creating BusinessEvents Profiles

BusinessEvents Profiles can be created by BusinessEvents Profile wizard. To open BusinessEvents Pro-
file wizard right-click on folder Profiles and select New > BusinessEvents Profile.
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Figure51. BusinessEvents Profile wizard

First page allow select predefined type of Profile:
• Enterprise - in default generates all outputs
• Printable - in default generates only PDF output
• QA Only - in default generates only QA output

On next page is possible select destination folder of created Profile and set name of new Profile.

http://www.pikeelectronic.com/


Date: 07/26/13

MakeDoc - User Manual

License owner: PIKE ELECTRONIC
MakeDoc for TIBCO made by PIKE ELECTRONIC.    All Rights Reserved. Page 52 of 152

Figure52. BusinessEvents Profile wizard - destination folder and Profile name

Wizard creates new Profile in selected folder after pressing Finish button.

2.3.1.2.3.2. Editing BusinessEvents Profiles

Existing BusinessEvents Profiles can be modified by BusinessEvents Profile Editor. Double click on Busi-
nessEvents Profile opens BusinessEvents Profile Editor.
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Figure53. BusinessEvents Profile Editor

BusinessEvents Profile Editor contains seven bookmarks.

First bookmark Profile general settings allows set Profile name, which is showed in generated document-
ation name. Profile author says who creates Profile. Project description contains short information about
Profile.

Output settings allow to set properties of generation process such as output formats to generate, paper
format, filter and two checkboxes for fast selecting all Units and Quality Assurance Rules to document.

Last Storage settings allow to set storage properties as Storage and Repository location.

Button Generate documentation starts documentation process.

Button Show Repository select las generated snapshot of this profile in MakeDocStorage.

Figure54. BusinessEvents Profile Editor - Units

BusinessEvents Profile has selected all Units to document in default. Unit means BusinessEvents Projec-
t. Second bookmark Units provides selection of Units to document and shows all Units which are stored
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in Profile's BusinessEvents Module project. All Units can be selected automatically by checkbox Select
all.

Figure55. BusinessEvents Profile Editor - Global Variables

Global Variables are variables used in BE project. It means you can change variable on one place.
Thanks to this are changes distribuated to all places where Global Variables are used. In this bookmark
you can select if you allow to enable or disable Global Variables substitution.(Project, Crossreference)

Figure56. BusinessEvents Profile Editor - Quality Assurance

BusinessEvents Profile has not selected Quality Assurance Rules to document in default. Last bookmark
Quality Assurance provides selection of Rules to apply on sources and shows all Rules which are stored
in Profile's BusinessEvents Module project. All Rules can be selected automatically by checkbox Select
all.
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Figure57. BusinessEvents Profile Editor - Custom Functions

Next bookmark Custom Functions provides selection of Custom Functions (*.jars) to allow to choose Cu-
stom Function and associate it with projects for documenting in this profile. All Custom Functions can be
selected automatically by checkbox Select all.

Figure58. BusinessEvents Profile Editor - Project Libraries

Project Libraries bookmark provides selection of Project Libraries (*.projlib) to allow to choose Project Li-
braries and associate it with projects for documenting in this profile. All Project Libraries can be selected
automatically by checkbox Select all.
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Figure59. BusinessEvents Profile Editor - Third Party Libraries

Last bookmark Third Party Libraries provides selection of Third Party Libraries (*.jar) to allow to choose
Third Party Libraries and associate it with projects for documenting in this profile. All Third Party Libraries
can be selected automatically by checkbox Select all.

Figure60. BusinessEvents Profile Editor - ThirdParty Libraries

2.3.1.2.4. Working with Filters

Chapter describes editing Filters which exists.
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2.3.1.2.4.1. Editing filters

Existing filters can be modified by BusinessEvents Filter Editor. Filter allows reduce generated document-
ation by selecting parts showed in BusinessEvents Filter Editor.

Figure61. BusinessEvents Filter Editor

Filter contains three parts. Projects, CrossReference and QualityAssurance. By deselecting parts is poss-
ible reduce generated documentation.

2.3.1.2.5. Working with Project Libraries

MakeDoc is able to document TIBCO BusinessEvents Project Libraries. In this chapter we will go through
project library setup. As well as other resources project library is represented by file. To document project
library we have to add project library resource to our documentation project. Process of adding project li-
brary is very similar to project creation. It holds wizard-editor fashion and offers batch project library files
creation too.

To add Project Libraries files click right-click on Project Libraries folder in MakeDoc Explorer and run
New->BusinessEvents Project Libraries. MakeDoc starts Project Libraries files creation wizard. Click Bro-
wse and navigate to the folder you would like to recursively search Project Libraries for. In this example it
is C:/example/BENewFeature.
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Figure62. New multiple Business Events Project Libraries Wizard

MakeDoc will now search for Project Libraries in selected folder. By default all detected libraries are sel-
ected for addition.
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Figure63. Add multiple Business Events Project Libraries Wizard - result page

Click Finish to add Project Libraries to our project. MakeDoc Explorer now should look like this:

Figure64. MakeDoc Explorer - added libraries

To edit Project Library settings just click on corresponding file and Project Library Editor is opened imme-
diately.
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Figure65. Project Libraries file editor

2.3.1.2.6. Working with Custom Functions

MakeDoc is able to document TIBCO BusinessEvents Custom Functions. Custom Functions are *.jar fil-
es, that contains customer functions which are used in BE project. In this chapter we will go through Cu-
stom Function setup. As well as other resources custom function is represented by file. To document cu-
stom function we have to add custom function resource to our documentation project. Process of adding
custom function is very similar to project creation. It holds wizard-editor fashion and offers batch custom
function files creation too.

To add Custom Functions files click right-click on Custom Functions folder in MakeDoc Explorer and run
New->BusinessEvents Custom Functions. MakeDoc starts Custom Functions files creation wizard. Click
Browse and navigate to the folder you would like to recursively search Custom Functions for. In this ex-
ample it is C:/example/BENewFeature.

http://www.pikeelectronic.com/


Date: 07/26/13

MakeDoc - User Manual

License owner: PIKE ELECTRONIC
MakeDoc for TIBCO made by PIKE ELECTRONIC.    All Rights Reserved. Page 61 of 152

Figure66. New multiple Business Events Custom Functions Wizard

First page allow set location of Custom Functions (*.jar): On the next page is possible select Custom Fu-
nctions from folder selected in URL.
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Figure67. New multiple Business Events Custom Functions Wizard - result page

Click Finish to add Custom Functions to our project. MakeDoc Explorer now should look like this:

Figure68. MakeDoc Explorer - added libraries

To edit Custom Functions settings just click on corresponding file and Custom Functions Editor is opened
immediately.
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Figure69. Custom Functions file editor

2.3.1.2.7. Working with ThirdParty Libraries

MakeDoc is able to document TIBCO BusinessEvents ThirdParty Libraries. ThirdParty Libraries are *.jar
files, that contains third-party libraries which are used in BE project. In this chapter we will go through Thi-
rdParty Libraries setup. As well as other resources thirdParty library is represented by file. To docume-
nt thirdParty library we have to add thirdParty library resource to our documentation project. Process of
adding thirdParty library is very similar to project creation. It holds wizard-editor fashion and offers batch
thirdParty library files creation too.

To add ThirdParty Libraries files click right-click on ThirdParty Libraries folder in MakeDoc Explorer and
run New->BusinessEvents ThirdParty Libraries. MakeDoc starts ThirdParty Libraries files creation wizard.
Click Browse and navigate to the folder you would like to recursively search ThirdParty Libraries for. In
this example it is C:/examples/libraries.
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Figure70. New multiple Business Events ThirdParty Libraries Wizard

First page allow set location of ThirdParty Libraries (*.jar): On the next page is possible select ThirdParty
Libraries from folder selected in URL.

http://www.pikeelectronic.com/


Date: 07/26/13

MakeDoc - User Manual

License owner: PIKE ELECTRONIC
MakeDoc for TIBCO made by PIKE ELECTRONIC.    All Rights Reserved. Page 65 of 152

Figure71. New multiple Business Events ThirdParty Libraries Wizard - result page

Click Finish to add ThirdParty Libraries to our project. MakeDoc Explorer now should look like this:

Figure72. MakeDoc Explorer - added libraries

To edit ThirdParty Libraries settings just click on corresponding file and ThirdParty Libraries Editor is op-
ened immediately.
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Figure73. ThirdParty Libraries file editor

2.3.1.2.8. Working with Rules

For working with Rules is used MakeDoc Quality Assurance editor described in Quality Assurance chapt-
er.

2.3.2. Generated Output

Documentation can be generated in HTML, PDF and DOCX format (depends on licensed products).
Each HTML document contains a tree navigation divided into three main parts - Project Documentation,
Cross-reference Documentation and Quality Assurance Documentation. HTML contains Quality Assur-
ance Documentation only if Quality Assurance Module is licensed. The Project Documentation part con-
tains list of projects and each project contains all its resources. Navigation items are links to HTML doc-
uments and the menu is updated according to actually displayed content. The PDF format of document-
ation has bookmarks which are similar in structure to the HTML navigation. The DOCX documentation is
another printable file format, which is also easy to edit and format.
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Figure74. Example of HTML navigation

2.3.2.1. Project Documentation

The Project documentation contains chapter for each documented project. The focus of this chapter is on
message and data processing. A project documentation may contains some or all of sections depending
on BusinessEvents Profile settings.
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Figure75. Example of HTML Project Documentation

2.3.2.1.1. Supported Resources
TIBCO BusinessEvents Module supports these resources:

• Cluster Deployment Descriptors
• Concepts
• Concept Views
• Event Views
• Global Variables
• Channels
• Project Views
• Rules
• Rule Functions
• Scorecards
• Shared HTTP Connections
• Shared JMS Connections
• Shared JNDI Configuration
• Simple Events
• Time Events

2.3.2.1.2. Cluster Deployment Descriptors
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Cluster Deployment Descriptor documentation consists of General Configuration, Object Management,
Database Concepts, Properties, Rule Sets, Function Groups, Destination Groups, Log Configuration, Ag-
ent Classes and Processing Units.

Figure76. Cluster Deployment Descriptor General Configuration and Object Management

General Configuration and Object Management contains the details of Cluster Name, Version, Database
Concepts and Properties.
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Figure77. Cluster Deployment Descriptor Log Configuration and Agent Classes

Log Configuration and Agent Classes contains the details of logging and Agent Classes.
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Figure78. Cluster Deployment Descriptor Processing Units

Processing Units contains the details of all Processing Units, Agents and Properties.

2.3.2.1.3. Concepts

Concept documentation consists of Concept Description, Dependency Diagram and Concept Properties.
Dependency Diagram looks like diagram in BusinessEvents Studio.
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Figure79. Concept documentation

2.3.2.1.4. Concept Views

Concept View documentation consists of Concept View Diagram and list of Items showed on View Diagr-
am with link to documentation item.
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Figure80. Concept View documentation

2.3.2.1.5. Event Views

Event View documentation consists of Event View Diagram and list of Items showed on Event View Diag-
ram with link to documentation item.
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Figure81. Event View documentation

2.3.2.1.6. Global Variables

Global Variable documentation consists Global Variable Description and Global Variable Configuration.
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Figure82. Global Variable documentation

2.3.2.1.7. Channels

Channel documentation consists of Channel Description, Driver Label, Config Method, Resource, Exte-
nded Configuration, Dependency Diagram and Destinations.

http://www.pikeelectronic.com/


Date: 07/26/13

MakeDoc - User Manual

License owner: PIKE ELECTRONIC
MakeDoc for TIBCO made by PIKE ELECTRONIC.    All Rights Reserved. Page 76 of 152

Figure83. Channel documentation

http://www.pikeelectronic.com/


Date: 07/26/13

MakeDoc - User Manual

License owner: PIKE ELECTRONIC
MakeDoc for TIBCO made by PIKE ELECTRONIC.    All Rights Reserved. Page 77 of 152

Figure84. Channel documentation - Dependency Diagram and Channel Destinations

2.3.2.1.8. Project Views

Project View documentation consists of Project View Diagram and list of Items showed on Project View
Diagram with link to documentation item.

http://www.pikeelectronic.com/


Date: 07/26/13

MakeDoc - User Manual

License owner: PIKE ELECTRONIC
MakeDoc for TIBCO made by PIKE ELECTRONIC.    All Rights Reserved. Page 78 of 152

Figure85. Project View documentation

2.3.2.1.9. Rules
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Rule documentation consists of Rule Description, Dependency Diagram, Sequence Diagram, Priority,
Chain, Declaration, Condition Text, Action Text.

Figure86. Rule documentation - Description and Dependency Diagram
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Figure87. Rule documentation - Sequence Diagram and Priority

Figure88. Rule documentation - Chain, Declaration, Condition and Action Text

2.3.2.1.10. Rule Functions

Rule Function documentation consists of Rule Description, Dependency Diagram, Sequence Diagram,
Virtual, Validity, Return Type, Scope, Body.
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Figure89. Rule Function documentation - Description and Dependency Diagram
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Figure90. Rule Function documentation - Sequence Diagram and Virtual

Figure91. Rule Function documentation - Validity, Return Type, Scope, Body

2.3.2.1.11. Scorecards

Scorecard documentation consists of Scorecard Description and Properties.
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Figure92. Scorecard documentation

2.3.2.1.12. Shared HTTP Connection

Shared HTTP Connection documentation consists of Shared HTTP Connection Description, Host, Port
and Alias.

Figure93. Shared HTTP Connection documentation

2.3.2.1.13. Shared JMS Connection
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Shared JMS Connection documentation consists of Shared JMS Connection Description, Resource Typ-
e, Connection Attributes, Naming Environment, Connection factory, Shared JNDI Config, Admin Factory
SSL Password and SSL Configuration.

Figure94. Shared JMS Connection documentation

2.3.2.1.14. Shared JNDI Configuration

Shared JNDI Configuration documentation consists of Shared JNDI Configuration Description, Resource
Type, JNDI Configure and Validate JNDI Security Context.
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Figure95. Shared JNDI Configuration documentation

2.3.2.1.15. Simple Events

Simple Event documentation consists of Event Description, Dependency Diagram, Event Properties, Se-
quence Diagram, Expiry Action, Payload String.
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Figure96. Simple Event documentation - Description and Dependency Diagram
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Figure97. Simple Event documentation - Properties and Sequence Diagram
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Figure98. Simple Event documentation - Expiry Action and Payload String

2.3.2.1.16. Time Events

Time Event documentation consists of Time Event Description, Dependency Diagram, Sequence Diagra-
m.
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Figure99. Time Event documentation

2.3.2.1.17. State Machines

State Machine documentation consists of Extended Properties, State Diagram and details of all Actions,
Expression, State Entities and Transitions.
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Figure100. State Machine documentation

2.3.2.2. Cross-Reference Documentation

This section contains three main subsections. Global Variables, Destinations and User Defined Cr-
ossReference.

2.3.2.2.1. Global Variables
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The Global Variables section of the document references information of all projects in the MakeDoc for
TIBCO solution. It contains two subsections.

The section Global Variables Reference is a list of all global variables. Global variables are structured
similar to TIBCO BusinessEvents Studio, but this structure is built among all project in the TIBCO Busi-
nessEvents Profile. Each global variable documentation contains table of its values, because global vari-
able can be defined in more than one project. Hyper-links to referencing resources (e.g. Channels) are
also included.

Figure101. Example of Global Variable Reference documentation

2.3.2.2.2. Destinations

The Destinations section of the document references information of all projects in the BusinessEvents
Profile.

The section Destinations Reference is a list of all Queues grouped by JMS Connection in JMS Messages
section. Every Queue contains graph with text part. Graph shows all Event which communicate with sel-
ected Queue and vice versa. Text part corresponds with the graph, but contains list of Events which only
communicate with selected Queue.

Destination documentation contains the visual cross-reference where the user can see near destination
neighborhood. Actually opened destination has yellow border for simpler orientation in the diagram. Eve-
ry diagram element is hyper-linked to its documentation page.
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Figure102. Example of Queue detail

2.3.2.2.3. User Defined CrossReference

The section User Defined CrossReference is special part of generated documentation. This part contains
documentation of JMS Connections and their usages by JMS Queue.

Content of User Defined CrossReference is driven by special files stored in BusinessEvents Module
project in folder Templates/cross/def/*. By editing or adding new files can be automatically added new
part of documentation. Adding and editing needs good knowledge of TIBCO BusinessEvents Module pro-
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cessing. Editing and adding new files is NOT RECOMMENDED. User Defined CrossReference is new
model and it will be improved and accessible to users in future.

Figure103. Example of JMS Connection in User Defined CrossReference

2.3.2.3. Quality Assurance Documentation

Quality Assurance Documentation part is described in Quality Assurance Module chapter.

2.4. TIBCO iProcess Module
TIBCO iProcess Module allows to generate documentation from selected TIBCO iProcess sources, such
as directories with sources. TIBCO iProcess Module can work with iProcess project created under TIBCO
iProcess.

All processes described in this chapter can be used in TIBCO iProcess Module.

2.4.1. Setup

Chapter describes how to setup the module. It starts with dialogs and then it continues with configuration
files.

2.4.1.1. Configuration

Configuration of TIBCO iProcess Modules is stored in ~/MakeDocConfig/nighthawk.properties for TIBCO
iProcess Module.

Property files contains:

settings.module=NGHTHAWKsettings.type=SNAPSHOT 
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settings.module=NGHTHA
n

File nighthawk.properties contains paths to TIBCO iProcess.

2.4.1.2. Dialogs

Chapter describes dialogs in module for TIBCO iProcess.

2.4.1.2.1. Creating TIBCO iProcess Module Project

Chapter describes creation of TIBCO iProcess Module project.

Figure104. New TIBCO iProcess Module Project wizard

Name of project can be set in next wizard page.
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Figure105. New TIBCO iProcess Module Project wizard - Project Name

MakeDoc creates main project structure after pressing Finish.

Figure106. Created project structure

Project contains three folders:
• Profiles - contains profiles for selecting TIBCO iProcess project to document, output format of docu-

mentation
• Projects - contains all TIBCO iProcess projects to document
• Templates - contains FreeMarker templates

2.4.1.2.2. Working with TIBCO iProcess projects
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Chapter describes creating and editing TIBCO iProcess projects. TIBCO iProcess project can link to di-
rectory with TIBCO iProcess project sources.

2.4.1.2.2.1. Creating TIBCO iProcess project

TIBCO iProcess project can be created by New Multiple iProcess Projects wizard. New Multiple iProcess
wizard allows create more TIBCO iProcess projects by one step.

Creating multiple iProcess projects

Right click on Project folder in TIBCO iProcess Module project and select New > iProcess Projects

Figure107. Multiple iProcess Projects

New Multiple iProcess Projects wizard allows selection of desired type of source - Folders. After setting
URL to directory, wizard tries to find all sources in selected folder recursively and shows all found TIBCO
iProcess Projects for selecting or deselecting found projects.
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Figure108. Found iProcess projects

Figure109. Created projects by Multiple iProcess Projects

2.4.1.2.2.2. Editing iProcess project

Existing iProcess projects can be modified by iProcess Project Editor. Editor allows change path to TIB-
CO iProcess source directory.
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Figure110. iProcess Project editor with directory source

2.4.1.2.3. Working with Profiles
This part describes how to work with iProcess profiles. Two profiles are created by default. Profiles in
general allows user to:

• start documentation process
• set output format - HTML, PDF, DOCX
• set paper format
• set filter
• set Storage setting - Storage, Repository location
• set subset of Units to be documented in this profile when 'Document all units' option is not used.

Figure111. Default Profiles in project

2.4.1.2.3.1. Creating iProcess Profiles

iProcess Profiles can be created by iProcess Profile wizard. To open iProcess Profile wizard right-click on
folder Profiles and select New > iProcess Profile.
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Figure112. iProcess Profile wizard

First page allow select predefined type of Profile:
• Enterprise - in default generates all outputs
• Printable - in default generates only PDF output

On next page is possible select destination folder of created Profile and set name of new Profile.

http://www.pikeelectronic.com/


Date: 07/26/13

MakeDoc - User Manual

License owner: PIKE ELECTRONIC
MakeDoc for TIBCO made by PIKE ELECTRONIC.    All Rights Reserved. Page 100 of 152

Figure113. iProcess Profile wizard - destination folder and Profile name

Wizard creates new Profile in selected folder after pressing Finish button.

2.4.1.2.3.2. Editing iProcess Profiles

Existing iProcess Profiles can be modified by iProcess Profile Editor. Double click on iProcess Profile op-
ens iProcess Profile Editor.
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Figure114. iProcess Profile Editor

iProcess Profile Editor contains two bookmarks.

First bookmark Profile general settings allows to set Profile name, which is showed in generated docume-
ntation name. Profile author says who creates Profile. Project description contains short information abo-
ut Profile.

Output settings allows to set properties of generation process such as output formats to generate, paper
format, filter and two checkboxes for fast selecting all Units and Quality Assurance Rules to document.

Last Storage settings allow to set storage properties as Storage and Repository location.

Button Generate documentation starts documentation process.
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Figure115. iProcess Profile Editor - Units

iProcess Profile has selected All Units to document by default. Unit means iProcess Project. Second
bookmark Units provides selection of Units to document and shows all Units which are stored in Profile's
iProcess Module project. All Units can be selected automatically by checkbox Select all.

2.4.2. Generated Output

Documentation can be generated in HTML, PDF and DOCX format. The Project documentation part con-
tains list of projects and each project contains all its resources. Navigation items are links to HTML doc-
uments and the menu is updated according to actually displayed content. The PDF documentation has
bookmarks which are similar in structure to the HTML navigation. The DOCX documentation is another
printable file format, which is also easy to edit and format.

2.4.2.1. Project Documentation

The Project documentation contains chapter for each documented project. The focus of this chapter is on
procedures and subprocedures. A project documentation may contains some or all of sections depending
on iProcess Profile settings.

http://www.pikeelectronic.com/


Date: 07/26/13

MakeDoc - User Manual

License owner: PIKE ELECTRONIC
MakeDoc for TIBCO made by PIKE ELECTRONIC.    All Rights Reserved. Page 103 of 152

Figure116. Example of HTML Project Documentation

2.4.2.1.1. Procedure

Procedures documentation consists of Sub-Procedures call, Parameters, Properties, Steps, Actions.
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Figure117. Procedures

2.4.2.1.2. Sub-Procedure

Sub-Procedures documentation consists of Parameters, Properties, Steps, Fields.
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Figure118. Sub-Procedures

2.4.2.2. Cross-Reference Documentation

Cross-Reference documentation is described in other part of this manual.

2.5. TIBCO EMS Module
TIBCO EMS Module allows to generate documentation from selected TIBCO EMS servers. TIBCO EMS
Module can work with EMS servers.

All processes described in this chapter can be used in TIBCO EMS Module.

2.5.1. Setup
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Chapter describes how to setup the module. It starts with dialogs and then it continues with configuration
files.

2.5.1.1. Configuration

Configuration of TIBCO EMS Modules is stored in ~/MakeDocConfig/pigeon.properties for TIBCO EMS
Module.

Property files contains:

settings.module=PIGEONsettings.type=SNAPSHOTtibco.home_path=C:/tibcotibco.ems.home=C
:/tibco/ems/6.0 

settings.module=PIGEONsettings.type=SNAPSHOTtibco.home_path=C:/
tibcotibco.ems.

settings.module=PIGEONsettings.type=SNAPSHOTtib
co.home_pa

settings.module=PIGEONset
tings.type
u

File pigeon.properties contains paths to TIBCO EMS.

2.5.1.2. Dialogs

Chapter describes dialogs in module for TIBCO EMS.

2.5.1.2.1. Creating TIBCO EMS Module Project

Chapter describes creation of TIBCO EMS Module project.
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Figure119. New TIBCO EMS Module Project wizard

Name of project can be set in next wizard page.
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Figure120. New TIBCO EMS Module Project wizard - Project Name

MakeDoc creates main project structure after pressing Finish.

Figure121. Created project structure

Project contains four folders:
• Filters - contains filters for reducing generated documentation
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• Profiles - contains profiles for selecting TIBCO EMS servers to document, output format of docume-
ntation

• Servers - contains all TIBCO EMS servers to document
• Templates - contains FreeMarker templates

2.5.1.2.2. Working with TIBCO EMS servers

Chapter describes creating and editing TIBCO EMS servers.

2.5.1.2.2.1. Creating TIBCO EMS Servers

EMS Servers can be created by EMS Servers wizard.

Creating EMS Server

Right click on Servers folder in TIBCO EMS Module project and select New > EMS Server

Figure122. Multiple iProcess Projects

This wizard allows you to create EMS Server object for documenting EMS Server. Server's Name, URL,
Port, User and Password are required. It is necessary to fill this information correctly.
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Figure123. Created EMS server

2.5.1.2.2.2. Editing EMS server

Existing EMS Servers can be modified by EMS Server Editor. Editor allows change connection info items
of EMS Server.

Figure124. EMS Server editor

2.5.1.2.3. Working with Profiles
Chapter describes working with Profiles. Two Profiles are created automatically. Profiles allow:

• start documentation process
• set output format - HTML, PDF, DOCX
• set paper format
• set filter
• set Storage setting - Storage, Repository location
• Servers to document
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Figure125. Default Profiles in project

2.5.1.2.3.1. Creating EMS Profiles

EMS Profiles can be created by EMS Profile wizard. To open New EMS Profile wizard right-click on folder
Profiles and select New > EMS Profile.
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Figure126. EMS Profile wizard

First page allows to select one of the predefined Profile types:
• Enterprise - in default generates all outputs
• Printable - in default generates only PDF output

On the next page is possible select destination folder of created Profile and set name of new Profile.

Wizard creates new Profile in selected folder after pressing Finish button.

2.5.1.2.3.2. Editing EMS Profiles

Existing EMS Profiles can be modified by EMS Profile Editor. Double click on EMS Profile opens EMS
Profile Editor.
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Figure127. EMS Profile Editor

EMS Profile Editor contains two bookmarks.

First bookmark Profile general settings allows set Profile name, which is showed in generated document-
ation name. Profile author says who creates Profile. Project description contains short information about
Profile.

Output settings allow to set properties of generation process such as output formats to generate, paper
format, filter and checkbox for fast selecting all Servers to document.

Last Storage settings allow to set storage properties as Storage and Repository location.

Button Generate documentation starts documentation process.
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Figure128. EMS Profile Editor - Servers

EMS Profile has not selected Server to document in default. Second bookmark Servers provides selec-
tion of Servers to document and shows all Servers which are stored in Profile's EMS Module project. All
Servers can be selected automatically by checkbox Select all.

2.5.1.2.4. Working with Filters

Chapter describes editing Filters which exists.

2.5.1.2.4.1. Editing filters

Existing filters can be modified by EMS Filter Editor. Filter allows reduce generated documentation by se-
lecting parts showed in EMS Filter Editor.
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Figure129. EMS Filter Editor

Filter contains two parts. Projects and CrossReference. By deselecting parts is possible reduce generat-
ed documentation.

2.5.2. Generated Output

Documentation can be generated in HTML, PDF and DOCX format (depends on licensed products). The
Project documentation part contains list of servers and each server contains all its resources. Navigati-
on items are links to HTML documents and the menu is updated according to actually displayed content.
The PDF documentation has bookmarks which are similar in structure to the HTML navigation. The DO-
CX documentation is another printable file format, which is also easy to edit and format.

2.5.2.1. Servers Documentation

The Servers section contains one chapter for each server in the solution.
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Figure130. Example of HTML Servers Documentation

2.5.2.1.1. Queues

Queues documentation consists of detail informations about each queue.

Figure131. Queue

2.5.2.1.2. Routes
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Routes documentation consists of detail informations about each route.

Figure132. Route

2.5.2.1.3. Topics

Topics documentation consists of detail informations about each topic.

Figure133. Topic

2.5.2.2. Cross-Reference Documentation

Cross-Reference documentation contains Routes between servers.

2.5.2.2.1. Routes

The Routes section contains EMS Servers and routes between them. Hyper-links to referencing servers
are included.
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Figure134. Example of Routes documentation

2.6. CrossReference Module
Note:  This feature is available only if you have purchased product CrossReference.

This module needs other modules (TIBCO BusinessWorks and TIBCO BusinessEvents and TIBCO iPro-
cess and TIBCO EMS module) to be installed.

CrossReference module connects a destinations common for TIBCO BusinessWorks, BusinessEvents,
iProcess and EMS modules and brings a documentation with hyperlinked resources.

2.6.1. Setup

Chapter describes how to setup the module. It starts with dialogs and then it continues with configuration
files.

2.6.1.1. Create a new CrossReference project
• In menu select File -> New -> CrossReference Documentation Project.
• Type name of CrossReference Documentation Project
• Click Finish

http://www.pikeelectronic.com/


Date: 07/26/13

MakeDoc - User Manual

License owner: PIKE ELECTRONIC
MakeDoc for TIBCO made by PIKE ELECTRONIC.    All Rights Reserved. Page 119 of 152

Figure135. CrossReference Documentation Project wizard

A new CrossReference Documentation project will be created and displayed in MakeDoc Explorer.

A CrossReference Documentation project contains two folders:
• Profiles - Here are stored defined profiles of CrossReference Documentation. There are 2 default

Profiles - Enterprise and Printable. Each profile has predefined settings for formatting output docu-
mentation.

• Templates - Here are templates for formatting the output of CrossReference Documentation.

Figure136. CrossReference Documentation Project in MakeDoc Explorer

2.6.1.1.1. Create a new CrossReference profile
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• Right-click on Profiles folder in concrete CrossReference project. Select New -> CrossReference
Profile.

• Select a predefined profile template, click Next
• Enterprise - in default generates all outputs
• Printable - in default generate only PDF output

• Type name of CrossReference Profile
• Click Finish

A new CrossReference Profile will be created and displayed in MakeDoc Explorer.

2.6.1.2. Setup CrossReference Profile
Profile Editor has 2 pages:

• Profile general settings - general settings
• Profiles - select profiles to document

General settings page allows:
• start documentation process
• set output format - HTML, PDF, DOCX
• set paper format
• set Storage setting - Storage, Repository location

Figure137. Profile general settings

2.6.1.2.1. Select Profiles

On the left side of editor is the list of all possible profiles in projects in MakeDoc's workspace. You can
check which profiles you want to document in CrossReference.

After click on some of profiles, on the right side are displayed settings of the concrete profile. Settings of
profile contains:

• Generate New Snapshot checkbox. If checked, a new snapshot of this profile is documented.
• Offset - type number of offset to select existing snapshot. 0 is the last generated snapshot, -1, -2, ...

are older snapshots.
• Select Snapshot - allows to select concrete snapshot.
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Figure138. Profiles selection tab

2.6.2. Generated Output

Documentation can be generated in HTML, PDF and DOCX format. Each HTML document contains a
tree navigation. Navigation items are links to HTML documents and the menu is updated according to
actually displayed content. The PDF documentation has bookmarks which are similar in structure to the
HTML navigation. The DOCX documentation is another printable file format, which is also easy to edit
and format.

Output of CrossReference documentation contains several main subsections: documentations of projects
selected in CrossReference (it can be BW, BE, BPM or EMS Documentation) and CrossReference
Documentation.
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Figure139. CrossReference Output

2.6.2.1. CrossReference Documentation

CrossReference Documentation contains a list of objects, which are used in selected projects. It can be
e.g. JMS Queues or Topics used in BW & BE & EMS projects, BW processes called by iProcess proced-
ures etc.

A concrete object documentation contains the visual cross-reference where the user can see near desti-
nation neighborhood. Actually opened destination has yellow border for simpler orientation in the diagra-
m. Every diagram element is hyper-linked to its documentation page.
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Figure140. Example of JMS Queue detail

2.7. RepositoryAnalyst Module
Repository Analyst needs at least one Base Module to be able to generate delta.

2.7.1. Setup

Chapter describes how to setup the module. It starts with dialogs and then it continues with configuration
files.

2.7.1.1. Configuration

Configuration of Repository Analyst Modules is out-of-box stored in ~/MakeDocConfig/rita.properties

http://www.pikeelectronic.com/


Date: 07/26/13

MakeDoc - User Manual

License owner: PIKE ELECTRONIC
MakeDoc for TIBCO made by PIKE ELECTRONIC.    All Rights Reserved. Page 124 of 152

Property files contains:

    settings.module=RITA    settings.type=ANALYSIS 
    settings.module=RITA    settin
od

2.7.1.2. Dialogs

Chapter describes dialogs in module Repository Analyst.

2.7.1.2.1. Creating Repository Analyst Module Project

Chapter describes creation of Repository Analyst Module project.

Figure141. New Repository Analyst Module Project wizard

Name of project can be set in next wizard page.
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Figure142. New Repository Analyst Module Project wizard - Project Name

MakeDoc creates main project structure after pressing Finish.
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Figure143. Created project structure

Project contains one folder:
• Profiles - contains profiles for selecting Repository Analyst project to document, output format of do-

cumentation and selecting input data.

2.7.1.2.2. Working with Profiles
Chapter describes working with Profiles. Two Profiles is created automatically. Profiles allow:

• start documentation process
• set output format - HTML, PDF, DOCX
• set paper format
• set Storage setting - Storage, Repository location
• selects Snapshots to compare
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Figure144. Default Profiles in project

2.7.1.2.2.1. Creating Repository Analyst Profiles

Repository Analyst Profiles can be created by Repository Analyst Profile wizard. To open Repository An-
alyst Profile wizard right-click on folder Profiles and select New > Repository Analyst Profile.
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Figure145. Repository Analyst Profile wizard location

First page allow select predefined type of Profile:
• Enterprise - in default generates all outputs
• Printable - in default generate only PDF output

On next page is possible select destination folder of created Profile and set name of new Profile.
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Figure146. Repository Analyst Profile wizard - destination folder and Profile name

Wizard creates new Profile in selected folder after pressing Finish button.

2.7.1.2.2.2. Editing Repository Analyst Profiles

Existing Repository Analyst Profiles can be modified by Repository Analyst Profile Editor. Double click on
Repository Analyst Profile opens Repository Analyst Profile Editor.
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Figure147. Repository Analyst Profile Editor

Repository Analyst Profile Editor contains two bookmarks.

First bookmark Profile general settings allows set Profile name, which is showed in generated document-
ation name. Profile author says who creates Profile. Project description contains short information about
Profile.

Output settings allows to set properties of generation process such as output formats to generate and pa-
per format.

Last Storage settings allow to set storage properties as Storage and Repository location.

Button Generate documentation starts documentation process.
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Figure148. Repository Analyst Profile Editor - Snapshot Selector

In second bookmark it's possible to select old and new Snapshots. These Snapshots are stored in Stor-
age and this bookmark represents view into Repository. Selection of concrete Snapshot is possible in two
ways. First way represents select of Repository and offset number specification. Offset is negative num-
ber which represents index in Repository, sorted from new Snapshot to older Snapshot. Zero number in
offset means current Snapshot. Second way is to select concrete Snapshot in tree (offset is set automati-
cally). In picture old Snapshot is selected by second way and new Snapshot by first one.

2.7.2. Generated Output

Chapter describes contents of generated output.

2.7.2.1. Repository Analyst

Repository analyst documentation can be generated in HTML and PDF format. Document is divided in-
to three main parts - Added items, Removed items and Changed items. Everyone of these parts corre-
sponds to adequate repository changes - added represents added files, removed deleted files from file
system and changed represents files of same name whose structure was modified. Each section cont-
ains also summary of numbers of adequate file's change.

Inner tree structure of these three parts is similar to structure used in Project and Cross-reference docu-
mentation.
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Figure149. Example of HTML navigation

Sections added items and removed items contain basic information of files added to new snapshot or de-
leted from old (base) snapshot. Below this basic information is displayed content of added or removed fil-
e.

Figure150. Description of added item

Section changed items contains basic information about compared files and also visualization of more
detailed changes of file structure. These changes are distinguished by color in this part of document.

Figure151. Description of changed item

Modified parts of elements are described by yellow color.
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Figure152. Visualization of modified parts of element

Deleted elements from the structure are described by red color (added elements by green color).

Figure153. Visualization of deleted parts of element

2.8. Quality Assurance
Note:  This feature is available only if you have purchased product Quality Assurance.
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Quality Assurance checks whether defined rules were followed in chosen projects and shows all occurre-
nces of violations of these rules. Its documentation can be generated together with project and cross-ref-
erence documentation, which brings advantage of hyperlinked resources, or separately as single docu-
ment. Output itself is divided into three parts - rules, projects and QA statistics. Therefore it is possible to
examine violations of rules which weren't followed from this two points of view. In QA statistics is possible
find information about QA rules (list of invalid rules, count of fired rules, count of checked objects).

2.8.1. Setup

Chapter describes how to setup the module. It starts with dialogs and then it continues with configuration
files.

2.8.1.1. Working with Rules

2.8.1.1.1. Quality Assurance Dialog
Note:  This dialog is available only if you have purchased product Quality Assurance.

This dialog is used for settings of Quality Assurance module. It is possible to choose which rules will be
used during Quality Assurance check. The rule is classified by its group, type and name (this combinati-
on has to be unique within solution). Chapter also reflects output chapter in documentation and rule's top-
ic group.

It can be opened by clicking on Quality Assurance tab within the Profile Editor.

Figure154. Quality Assurance Page

There are some options how to work with rules on this page - you can select project to check and assign
concrete rules to selected project (to apply them to the project within a QA check).

• 1. Enable Rule - check the checkbox belonging to a required rule (a row in the left "Quality Assur-
ance rules to document in this profile" panel)

• 2. Assign project to a rule desired to check - select a rule in the left hand side panel and choose
projects by using check boxes in the right hand side panel (Units to document for selected Rule)
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2.8.1.1.2. Quality Assurance Rule Editor
Note:  This dialog is available only if you have purchased product Quality Assurance.

This dialog is used for editing of Quality Assurance rules. It is possible to open MakeDoc's *.rule files in
order to modifying them. The rule is classified by its group, type and name (this combination has to be
unique within MakeDoc's project). Group also reflects output chapter in documentation and rule's topic gr-
oup.

It can be opened by double-clicking on *.rule item from MakeDoc Explorer view.

Figure155. QA Rule General Settings Page

There are several fields to modify within rule:
• Group - Specifies the group to which rule belongs - this division also determines how the output do-

cumentation will be structured.
• Type - It determines the rule within the group (chapter) - it usually specifies exact item, to which the

rule refers.
• Description - Kind characteristics of rule - every rule in chapter should have the same description.
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• Mask - Together with configuration items allows to add extra information for concrete rule violation
to output document.

• Name - Name of the rule for better recognition and orientation.
• Severity - Severity of rule - rules are also sorted in output documentation by this item.
• Filter - File types to which the rule refers to can be chosen.
• Configuration - Detailed configuration of rule which depends on its type and implementation detail-

s.

2.8.1.2. Rule types description

2.8.1.2.1. XPathRuleChecker

Groups of preconfigured XPathRuleChecker types of rules with instance distinction and violation descrip-
tion:

• Incorrect description - Item doesn't contain any description or description too short
• Processes, AE Schemas, Archives, WSDLs, RV Transports, Shared JDBC Connections,

HTTP Proxies, Shared HTTP Connections, Shared FTP Connections, Shared iProcess Con-
nections, Shared Variables, Job Shared Variables, Service Agents, Concepts, Concept Views,
Events, Channels, RuleSets, RuleFunctions, Scorecards, Shared JNDI Configs, Shared JMS
Connections, BusinessConnect Connections

• Presence of process label - Process has label
• Processes

• Missing archive signature - Enterprise archive has no signature
• Archives

• Missing EAR signature - EAR file has no signature
• EARs

• Hardcoded connection parameters - Hardcoded connection
• JDBC connections
• JMS connections
• JNDI connections
• HTTP connections
• FTP connections

• Missing XSD annotation - Process doesn't contain any XSD annotation
• XSDs

• Missing response activity - Process has starter activity, but has no adequate response activity
• HTTP response activities
• SOAP response activities
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Figure156. XPathRuleChecker particular violation

This type of rule allows to create XPath expression which is used to check TIBCO resources (xml files).
Violation will be discovered if this expression is evaluated to false. Example in picture above shows desc-
ription of archive which isn't filled in.

Figure157. XPathRuleChecker configuration

In configuration section of  Rule Settings dialog   on page   is possible to set XPath expression,
which will be evaluated and also description of this particular violation.
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Figure158. XPathRuleChecker particular violation documentation output

2.8.1.2.2. MessageConfirmationRuleChecker

Groups of preconfigured MessageConfirmationRuleChecker types of rules with instance distinction and
violation description:

• Presence of messages confirmation activities - Messages consumed by activities are not confi-
rmed

• JMS activities
• RV activities
• Adapter activities
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Figure159. MessageConfirmationRuleChecker particular violation

This type of rule allows to check whether is present in process for activity appropriate confirmation activity
(or activity has auto confirmation set). Example in picture above shows missing corresponding confirmati-
on activity for JMS Queue Receiver. Violation will be discovered in this case.

Figure160. MessageConfirmationRuleChecker configuration

In configuration section is possible to choose from three types of activities which will be checked - JMS,
RV or Ada.
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Figure161. MessageConfirmationRuleChecker particular violation documentation output

2.8.1.2.3. DirectoryStructureRuleChecker

Groups of preconfigured DirectoryStructureRuleChecker types of rules with instance distinction and viola-
tion description:

• Incorrect directory structure - Directory structure check failed
• Directories
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Figure162. DirectoryStructureRuleChecker particular violation

This type of rule allows to check whether the directory structure of project is followed as specified. Exam-
ple in picture above shows missing SharedResources folder in project (SharedJMSResources folder is
used instead).

Figure163. DirectoryStructureRuleChecker configuration

It is possible to define required and forbidden paths in configuration section.
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Figure164. DirectoryStructureRuleChecker particular violation documentation output

2.8.1.2.4. DestinationFormatRuleChecker

Groups of preconfigured DestinationFormatRuleChecker types of rules with instance distinction and viola-
tion description:

• Hardcoded or incorrect format of destination name - Destination names are hardcoded or do
not fulfill given regular expressions

• JMS destination activities
• RV destination activities
• Ada transport destination activities
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Figure165. DestinationFormatRuleChecker particular violation

This type of rule allows to check whether destination names in activities are hardcoded (without using
global variables) or if it's name suits specified regex expression. Example in picture above shows hardc-
oded name of subject in Invoke an Adapter Request-Response Service.

Figure166. DestinationFormatRuleChecker configuration

In configuration section is possible to choose from three types of activities which will be checked - JMS,
RV or Ada - and also specify regex expression for the format of name of these destinations.
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Figure167. DestinationFormatRuleChecker particular violation documentation output

2.8.1.2.5. ContextXPathRuleChecker

Groups of preconfigured ContextXPathRuleChecker types of rules with instance distinction and violation
description:

• Incorrect description - Item doesn't contain any description or description too short
• Starter activity, activities

• Hardcoded activities timeout - Activity has hardcoded timeout property
• JDBC activities
• RequestReply activities

• Hardcoded endpoints - Activity has hardcoded endpoint URL
• SOAP activities
• HTTP SendRequest activities

• Unused ADB Adapter - Activity references ADB Adapter service
• ADB activities
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Figure168. ContextXPathRuleChecker particular violation

This type of rule allows to create XPath expression which is used to check settings of items in one global
context - for example settings of activities in process. Example in picture above shows hardcoded timeout
property of SOAP Request Reply activity. Violation will be discovered if XPath expression is evaluated to
false.

Figure169. ContextXPathRuleChecker configuration

In configuration section concrete XPath expression used in context can be specified. There's also need
to specify the context itself - it can be done by filling ContextNodeXPathExpression. For distinction of text
output of discovered violation, there's also possible to set context placeholder, which can be used in Ma-
sk section of Rule Settings dialog, and it's value is specified by result of evaluation of ContextNameXPat-
hExpression field of configuration section.
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Figure170. ContextXPathRuleChecker particular violation documentation output

2.8.1.2.6. CMNameConflictRuleChecker

Groups of preconfigured CMNameConflictRuleChecker types of rules with instance distinction and violati-
on description:

• Multiple CM names - CM name conflicted
• RV Transports
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Figure171. CMNameConflictRuleChecker particular violation

This type of rule allows to check whether RV activities with same CM name exist in project. Example in
picture above shows these two items with the same CM names filled in.
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Figure172. CMNameConflictRuleChecker configuration

If checkByRvNetwork in Configuration section is set to true, conflicts are solved for each RV network sep-
arately, otherwise all transports are checked together and are considered to belong to the same network.

Figure173. CMNameConflictRuleChecker particular violation documentation output

2.8.1.2.7. ActivityTransitionsRuleChecker

Groups of preconfigured ActivityTransitionsRuleChecker types of rules with instance distinction and viola-
tion description:

• Incorrect transitions - 'Otherwise' or 'Success' transition is not present
• Activities
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Figure174. ActivityTransitionsRuleChecker particular violation

This type of rule allows to check whether correct transitions are used from activity. This can be assured
by presence of otherwise type of transition (when conditionals are present) or simple success transition.
Example in picture above shows that only transitions with conditional expression leads from start activity,
therefore the violation was discovered.

Figure175. ActivityTransitionsRuleChecker particular violation documentation output

2.8.2. Generated Output
Chapter describes contents of generated Quality Assurance analysis output. The Quality Assurance out-
put is divided to three parts:

• List of violated rules
• List of projects violated at least one rule
• QA statistics
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Figure176. Quality Assurance HTML output

2.8.2.1. Quality Assurance over Rules

Chapter describes contents of generated output within the Quality Assurance module from the point of
view of rules. This menu item provides you a view of violations over concrete rules sorted by its severi-
ty alphabetically. Once you expand a rule menu item the list of objects violated this concrete rule appear-
s. The big advantage of this view is that you can click on the hyperlinked paths of objects (violators) and
you are able to move to the violator very simple and very quickly.

Figure177. Quality Assurance over Rules

2.8.2.2. Quality Assurance over Projects

Chapter describes contents of generated output within the Quality Assurance module from the point of
view of projects. This menu item uncovers you a list of all projects where at least one rule was violated.
Once you click on a concrete project's object displayed in this list you are able to see all rules violated on
this item.
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Figure178. Quality Assurance over Projects

2.8.2.3. Quality Assurance Stattistics

Chapter describes contents of generated output within the Quality Assurance module from the point of vi-
ew of rules. This menu item provides you a global summary of your QA Rules. How many times rule fired.
How many objects was checked by rule. Also list of invalid QA rules.

Figure179. Quality Assurance Stattistics
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3. Troubleshooting

This chapter describes problems that might arise with MakeDoc release and it's solutions.

Symptom Solution

Generation process ends with an error Too many
open files when generating under GNU/Linux.

There is limit under GNU/Linux systems for how
many files can be opened by certain user simulta-
neously. It is set to 1024 by default. Increase this
limit for user running MakeDoc to generate docu-
mentation successfully. This limit can be specified
in /etc/security/limits.conf. Using * instead of user-
name will affect all users on target machine.

Generation process ends with an error java.lang.-
OutOfMemoryError: Java heap space

Increase amount of memory available for MakeD-
oc by the help of Window -> Preferences -> Make-
Doc -> Base configuration dialog.
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